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Компьютерная графика

        Лекция 1

Десятилетие назад машинная графика считалась частью системного программирования для ЭВМ. Сейчас это уже вполне самостоятельная область деятельности. 

С помощью ЭВМ сейчас решаются многие задачи геометрического характера. В машине синтезируются простые и сложные геометрические образы – поверхности, тела, структуры. Например, чертежи, схемы, фотоснимки  и т.д. 

Каждый, кто имеет дело с компьютерной графикой, рано или поздно осознает, что для уверенной работы необходимо владение несколькими программами. Дело в том, что на разных этапах подготовки графики приходится использовать разные редакторы. К тому же идеальных программ нет – некоторые лучше делают одно, некоторые другое.

Приведу перечень программ, без которых трудно представить сколь угодно серьезную работу.

1. Программа обработки растровой графики (для коррекции отсканированных изображений);

2. Программа векторной графики (для изготовления рекламной продукции и полно цветных печатных изданий; для создания графических элементов; для вставки в web – сайты, электронные презентации и.д.; для вывода на печать графических изображений);

3. Редактор анимационной графики (для создания фильмов);

4. Для тех кто занимается web – дизайном, кроме текстового редактора необходимого для написания HTML – кода,  понадобится и визуальный редактор web – страниц, такой как Microsoft FrontPage.

5. Различные вспомогательные средства: такие как программы распознавания текста, просмотра графики и свертывания документов.

Но независимо от того с каким программным обеспечением вы работаете, вам необходимо знать основные принципы дизайна, благодаря которым можно выбрать удобное решение в работе.

Материалы, с которыми приходится иметь дело в дизайне – это форма, цвет, текстура, размер, шрифты. Из них дизайнер составляет некое сочетание, в котором должны быть выдержаны основные принципы: 

· Единство;

· Контраст;

· Баланс.

Цвет – один из основных аспектов восприятия графики. Различают фоновые и цвета спектра.

Фоновые цвета 

1. белый – лучший цвет фона;

2. серый – хороший цвет;

3. черный – угнетающий цвет, нов зависимости от тематики подходит в качестве фона.

Цвета спектра – располагаются в порядке от теплого к холодным:

1.  красный – возбуждающий;

2. розовый  - цвет надежды;

3. оранжевый – тепло, веселье;

4. коричневый – приземленность, суета;

5. темно-желтый – недоверие,  скупость;

6. желтый – солнце, радостная бодрость;

7. зеленый – успокаивает;

8. сине-зеленый – напряжение;

9. голубой – рассеивающий;

10. синий – душевный покой, деловой цвет;

11. фиолетовый – смирение, снижает работоспособность;

12. пурпурный – торжество, королевский цвет.

Цветовой круг – полный переход цветов спектра, расположенный по окружности (но цветов фона там нет). Цвета расположенные на противоположных сторонах этого круга образуют контрастные пары и хорошо сочетаются. Если надо выбрать три цвета, то лучше выбирать цвета расположенные равносторонним треугольником. Не следует брать цвета расположенные близко друг к другу.

Форма – оказывает значительное эмоциональное влияние на зрение.

Условно можно разделить формы на:

· круг;

· квадрат;

· прямоугольник;

· треугольник;

· зигзаг.

Круг – люди мягкие, готовые компромисс;

Квадрат – педанты, любящие порядок;

Прямоугольник – люди в поиске;

Треугольник – надежность;

Зигзаг – творческие натуры.


При всех разнообразиях вкусов и индивидуальных предпочтений, существуют определенные пропорции предметов, которые следует выдерживать (наклон крыши 60 градусов).


Существует правило золотого сечения – это такое соотношение размеров объекта, при котором объект укладывается в прямоугольник со сторонами А и В, причем В=0.618А или В так относится к А, как А к А+В. Этот закон был обнаружен в древние времена и считается эталоном пропорциональности. 

Общепринятые правила оформления

Размещение текстовой и графической информации на странице имеет определенный порядок, нарушать который не следует.

Например: деловое письмо.

В одном из верхних углов располагается логотип фирмы. Если логотип ставится внизу, он ассоциируется с печатью или подписью фирмы и имеет малый размер. Вверху логотип может занимать до 1/3 листа. 

Если на странице присутствует текст, то заголовок выравнивают по центру и делают его жирнее, чем сам текст. Ширина текста должна быть не менее 2/3 ширины листа (при отсутствии рисунков или фотографий). 

Информация должна быть легко доступной для восприятия. Текст лучше всего выводить черными буквами на светлом фоне.

Замечание Избыток информации может существенно затруднять поиск и понимание материала. Поэтому при размещении информации и рисунков следует придерживаться логической и простой структуры. Это особенно остро понимаешь при поиске информации в Интернете.

Web - сайты

Занимаясь web – дизайном, нужно иметь в виду несколько особенностей:

1. web – страницы создаются в расчете на просмотр на компьютере;

· достоинством компьютерной графики является свечение монитора, благодаря чему можно получить гораздо широкий диапазон цветов;

· усиливает восприятие и трехмерная графика и анимация;

· со шрифтами и текстом можно обходится более свободно.

К недостаткам можно отнести необходимость придерживаться стандартных шрифтов.

2. следует учитывать технические ограничения, связанные с технологиями обмена данными в Интернете:

Интернет состоит из множества компьютеров, объединенных линиями связи в сеть. Источником информации является сервер –на их жестких дисках находятся файлы с HTML –страницами, доступными для просмотра.

Серверы предоставляют клиентам возможность просматривать web – сайты с помощью браузеров – Intertet Explorer и других.

Сервер работает под управлением специальной программы. И собственно сайт, на который вы попадаете, состоит из множества файлов разного назначения.

Обычно для изготовления сайта задействовано несколько человек:

· заказчик ставит задачу;

· web – дизайнер готовит графику и делает оформление сайта;

· web – программист пишет программные модули для вставки на страницы;

· web – мастер все компонует и размещает на сервере. 

Графику в Интернете можно разделить на две большие группы: 

· информационную;

· украшающую.

Требование к информационной – быстрый и удобный доступ; декоративная графика должна быть не навязчива и занимать небольшой объем.

Для информационной графики главным средством является предварительный просмотр. Векторная анимация позволяет добавить в информационную часть сайта настоящую мультипликацию. Тем самым повышая эмоциональное воздействие на посетителя.

Декоративная графика должна только подчеркивать информацию, ане отвлекать от нее.

Важное место в декоративной графики имеет фон. Его надо делать таким, чтобы файл был минимального размера. Особое внимание надо уделять первой странице.

Основные понятия компьютерной графики

Цветовые модели – это система представления цветов с помощью ограниченного числа доступных красок цветовых каналов монитора.

Замечание  Не следует путать с палитрой.

Цветовая модель предполагает создание оттенков на базе сложных или вычитания основных цветов.

Разностные цветовые модели ориентированы на полиграфию (CMYK)/ 

Цветовые модели на основе сложения предназначены для демонстрации изображений на мониторе.

Модель RGB – самая распространенная цветовая модель при воспроизведении изображения на экране монитора. В ней используются цвета трех лучей монитора: красного, зеленого, голубого. Интенсивность – от 0 до 255. Чем выше интенсивность, тем темнее цвет. 

Существуют также и другие модели: HSB, HSV, HLS, YIO, LAB.

Палитра – набор цветов составленных на основе определенной цветовой модели. Палитру можно создать самостоятельно.

Глубина цвета изображения определяется количеством битов, выделенных для хранения информации о цвете одного пикселя.

Чем больше битов на пиксел мы используем, тем большее количество оттенков становится доступно, тем так же доступнее более глубокие цвета. Однако одновременно растет и размер файла.

Разрешающая способность - это количество точек изображения, выводимое монитором или принтером на отрезок длиной один дюйм. Чем выше разрешение изображения, тем качественнее передача переходов цвета и тем больше размер файла.

Сглаживание применяется для смягчения границ на изображении, в результате чего картинка становится гладкой. Но иногда чрезмерное сглаживание ведет к сильному размыванию изображения и ухудшает его.

Шрифты Современные дизайнеры имеют в своем распоряжении сотни шрифтов. Однако использование более 3-4 шрифтов на одной странице является дурным тоном. Не надо боятся экспериментировать, но и не следует также увлекаться экстравагантностью шрифтов.  

Форматы графических файлов

Растровые форматы

Растровое изображение состоит из элементарных точек (пикселов). В графическом файле растрового формата ВМР (BitMap) хранятся координаты точек изображения и значения цвета каждой их них. Объем файла очень велик. 

В файлах формата GIF (Graphics Interchange Format) близко расположенные одинаковые по цвету, точки группируются в горизонтальные линии. Это позволяет существенно сократить объемы файлов. Однако этот формат не дает возможности сжимать фотографии.

Поэтому был изобретен формат  JPEG (или JPG) В этом формате реализуется алгоритм сжатия, изменяющий размер пикселов изображения. Т.о. можно уменьшать размер графического файла.

Относительно новым является формат PNG специально разработанный для Интернета. Этот формат обладает важным свойством – в нем можно хранить маску прозрачности изображения. Файлы этого формата доступны всем пользователям без необходимости установки дополнительных модулей.

Векторные форматы

Предположим, у нас есть рисунок дуги. В растровом формате будут сохранены координаты и цвет всех точек дуги и каждой точки фона. Однако, при описании дуги надо только четыре геометрических параметра: радиус, центр, координаты начала и конца дуги. 

В векторной графике элементы изображения рассматриваются как геометрические объекты с набором параметров. 

Недостатком является то, что векторное изображение не так реалистично как растровый рисунок.
Обзор распространенных графических редакторов

Итак, лучшие графические редакторы:

1. Редактор векторной графики CorelDraw 11.

2. Редактор анимированной векторной графики Macromedia Flash 5/

3. Редактор Web-страниц Microsoft Front Page 2002.

4. Редактор растровой графики Adobe Photoshop 7.

По степени и комфортности интерфейса лидером является Microsoft. Можно с уверенностью сказать, что для создания Web-сайтов наилучшим средством будет программа Front Page. Интерфейс редактора CorelDraw так же прост и понятен. Сложность редактора вызвана обилием его возможностей.

Продукция Adobe отличается почти полным отсутствием понятных подсказок и неполным справочником.

Общие принципы работы в графических редакторах

1. Создание нового или открытие существующего файла.

2. Выделение объекта или области.

3. Наложение эффекта либо активизация инструмента.

4. Снятие выделения.

5. Сохранение файла.

Лекция 2


Вычерчивание кривых линий и графиков функций, задаваемых уравнениями в явном виде


Автоматическое получение графиков функций было едва ли не первым практическим применением машинной графики. 


Графики функций обычно представляют собой кривые линии. Поставим обратный вопрос: всякая ли кривая линия будет графиком некоторой функции. Стоит ли считать функцией окружность, если это контур детали или граница отверстия.


Функции обычно рассматривают однозначные, т.е. такие когда одному значению аргумента соответствует одно значение функции. Но этим свойством не обладает даже окружность. С другой стороны, и окружность и различные другие линии имеют свое аналитическое выражение, их уравнения записываются в различных формах.


Нетрудно записать эти уравнения в явном виде, например, окружность, разрешив его относительно любой из координат
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Если линии строятся с помощью явного уравнения, координате аргументу придают постепенно увеличивающееся или уменьшающееся значение и всякий раз подсчитывают значение координаты-функции. Найденные точки соединяют отрезками.


В качестве исходных данных для получения конкретной дуги линии определенного типа задается аналитическая модель. В ее составе – начальное и конечное значение координаты-аргумента, шаг – всегда положительное значение.


Возьмем, например, уравнение синусоиды. Но не простейшем виде, а с линейными преобразованиями аргумента и функции, чтобы линию можно было чертить различными способами (высота, масштаб).


[image: image5.wmf](

)

(

)

S

x

x

A

y

y

/

2832

/

6

sin

0

0

*

-

*

+

=


Здесь 
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Таким образом, имея уравнение любой кривой можно написать программу вычерчивания ее графика.


В основе этих действий лежит концепция «вычисляй и сразу выдавай». Вычисленная точка сразу выводится на экран монитора или на печать.


Но иногда требуется другая стратегия: вычисляя точки кривой, написать их координаты, чтобы затем использовать полученную координатную модель для различных целей. 


Уравнение, которое было приведено в качестве примера, записано в явном виде. Однако в двумерном пространстве линии могут быть заданы параметрически – двумя уравнениями, явно выражающими обе координаты через значение некоторого параметра
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Параметрические линии по форме могут быть гораздо более разнообразными, чем описываемые явными уравнениями.


Чтобы параметрическое представление линии не показалось слишком сложным, линия может быть задана, например, двумя не явными уравнениями, содержащими (каждое) две координаты и параметр.
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Запрограммировать вычерчивание параметрической линии не сложно, например, эллипс. Его параметрические уравнения:
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Таким образом, мы рассмотрели вычерчивание кривых линий и графиков функций, задаваемых уравнениями в явном и неявном виде при работе с растровой графикой.


Основы графического представления информации при работе с векторной графикой.

Двумерное пространство


Вычисление в плоскости не представляет труда и основаны на понятиях планиметрии и аналитической геометрии.


Основные операции

1. Преобразование координат пространства в координаты экрана дисплея.


Одна из особенностей геометрического моделирования состоит в том, что она позволяет пользователю работать в своем собственном пространстве, не заботясь о последующем представлении информации на экране.


Для связи пространств пользователя и экрана в них выделяются окна прямоугольной формы, края которых параллельны координатным осям. Переход от одного пространства к другому состоит в определении соотношения между точками с координатами 
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2. Поиск пересечений

Окно пользователя определяется координатами нижнего левого 
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И верхнего правого 
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 углов, окно экрана – аналогично 
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Из очевидных соотношений 
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можно получить выражение для связи координат
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Поиск пересечений


Пересечения плоских объектов находятся с помощью правил аналитической геометрии на плоскости. Рассмотрим в качестве примера пересечение двух прямых, заданных уравнениями:
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Очевидно, надо решить простую систему из двух уравнений с двумя неизвестными. Сначала вычислим определитель:
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Если  
[image: image31.wmf]EPS
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, прямые считаются параллельными (
[image: image32.wmf]EPS

- очень малая величина), в противном случае координаты точки пересечения определяются выражениями:
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Пересечение окружности 
[image: image35.wmf]C

 с известными координатами центра (
[image: image36.wmf]C

X

, 
[image: image37.wmf]C
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), радиусом 
[image: image38.wmf]R

 и прямой 
[image: image39.wmf]D

. Запишем уравнения окружности и прямой в виде
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Проверим сначала, существует ли хотя бы одна точка пересечения. Для этого расстояние от центра окружности до прямой должно быть менее или равно радиусу окружности:
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Если это условие выполняется, для решения задачи достаточно решить систему уравнений (1) и (2). Введем обозначения:
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Тогда для двух решений имеем:
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Пересечение двух окружностей заданных координатами центров (
[image: image48.wmf]1
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, 
[image: image49.wmf]1
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) и (
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) и радиусами 
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. Сначала необходимо проверить, что окружности не являются концентрическими (т.е. расстояние между их центрами больше 
[image: image54.wmf]EPS

). После этого находим выражение для радикальной оси (радикальная ось двух окружностей представляет собой геометрическое место точек, из которых можно провести касательные одинаковой длины к этим окружностям) окружностей и задача сводится к предыдущему случаю: отыскание точек пересечения (если они существуют) радикальной оси и одной из окружностей.

Вычисление периметров и площадей


Эти вычисления выполняются без труда для фигур, представляющих собой многоугольники. Из графических представлений легко получить правила вычислений. Пусть имеется замкнутый многоугольник с 
[image: image55.wmf]N

 вершинами. Обозначим через 
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 координаты 
[image: image57.wmf]i

- ой вершины. Тогда можно показать, что периметр 
[image: image58.wmf]P

 и площадь 
[image: image59.wmf]S

 вычисляются по следующим формулам:
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Замечание Приведенные формулы применимы только к многоугольникам.

Геометрические преобразования на плоскости

Геометрические преобразования используются для перемещения и модификации объектов. Преобразования представлены в матричном виде с использованием приведенных выше сведений об однородных координатах. Последние необходимы еще и потому, что без них трудно обойтись при описании преобразования переноса,
Геометрическое преобразование, примененное к объекту или сово​купности объектов, может быть композицией (последовательностью) нескольких преобразований. Для его описания будем использовать матрицу, представляющую собой произведение матриц более простых преобразований (что является следствием ассоциативности матричного умножения).
Основные преобразования следующие:
· преобразование переноса на вектор Т;
· преобразование поворота относительно начала координат на угол а;
· преобразование масштаба на вектор Е (умножение координат объекта
на координаты вектора Е).
Рассмотрим математические выражения для основных преобразова​ний (исходный объект - вектор 
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• Преобразование переноса на вектор 
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Легко показать, что в однородных координатах матрица, описывающая это преобразование, имеет вид
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а преобразование вектора 
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• Преобразование поворота относительно начала координат на угол а. Координаты преобразуются по следующему правилу:   
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Отсюда легко получается матрица преобразования:
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Матричная запись преобразования:
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• Преобразование масштаба на вектор 
[image: image74.wmf](
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Матрица преобразования:
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Матричная запись преобразования:
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Цепочка преобразований

Более сложные преобразования можно определить как цепочку ос​новных преобразований, примененных последовательно. Матрицу слож​ного преобразования будем искать в виде произведения матриц преобра​зований, составляющих цепочку.
Предположим, что к объекту применяется преобразование переноса на вектор 
[image: image79.wmf](
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, а затем преобразование попорота относительно начала координат на угол а. Выполним сначала перенос, обозначив результат через 
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Затем выполним поворот, обозначив результат через  
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Окончательно получаем
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Воспользуемся свойствами ассоциативности матричного умножения и выполним сначала умножение матриц 
[image: image85.wmf](
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. Результат будет представлять собой матрицу полного преобразования:
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По аналогии с приведенными здесь рассуждениями можно определить матрицу любого сложного преобразования, состоящего из цепочки преобразований.


Пример 1. Определить матрицу преобразования, соответствующего повороту на угол 
[image: image88.wmf]a

 относительно 
[image: image89.wmf](
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Для решения этой задачи сначала отметим, что такое преобразование можно осуществить в три этапа:

1) преобразование переноса на 
[image: image90.wmf]C

-

  для того, чтобы совместить центр поворота с началом координат (так как нам известна матрица преобразования поворота только относительно начала координат);

2) преобразование поворота на угол 
[image: image91.wmf]a

 относительно начала координат;
3) преобразование переноса на 
[image: image92.wmf]C

 для возврата центра поворота в прежнее положение.
Полное преобразование будет иметь вид:
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[image: image94.wmf]=
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[image: image95.wmf]=
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[image: image96.wmf]1
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Пример 2. Определить матрицу, соответствующую преобразованию объекта с центром в точке 
[image: image97.wmf](
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 и масштабом 
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Для решения этой задачи преобразование можно осуществить в три этапа:

1) преобразование переноса на 
[image: image99.wmf]C

-

 ;

2) преобразование масштаба на вектор 
[image: image100.wmf]R

;

3) преобразование переноса на 
[image: image101.wmf]C

.

Матрица преобразования имеет вид:
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[image: image103.wmf]=
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Лекция 3 Геометрические преобразования в трехмерном пространстве.

Геометрические преобразования в трехмерном пространстве осу​ществляются так же, как и на плоскости. Таким же образом определяют​ся основные преобразования, и матрицы сложных преобразований полу​чаются умножением соответствующих простых матриц.
Описание преобразований в трехмерном пространстве немного слож​нее, чем для плоскости. Например, преобразование произвольного поворота представляется в виде комбинации преобразований поворотов относительно трех осей. Как и в плоскости, определим три основных преобразования, включающие преобразование поворота, которое в свою очередь состоит из трех последовательных преобразований.
Основные преобразования:
· преобразование переноса на вектор 
[image: image105.wmf]T

;
· преобразования поворотов вокруг оси 
[image: image106.wmf]X

на угол 
[image: image107.wmf]a

, вокруг оси 
[image: image108.wmf]Y

 mi
угол 
[image: image109.wmf]b

, вокруг оси 
[image: image110.wmf]Z

 на угол 
[image: image111.wmf]c

;
· преобразование масштаба.
Матрицы  основных  преобразований  легко  получить  из  следующих определений:

· Матрица преобразования переноса на вектор 
[image: image112.wmf](
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· Матрица преобразования поворота (углы показаны на рисунке):

[image: image114.emf]YXZ


Левая система координат


[image: image115.emf]YXZ


Правая система координат

Рис.1. Углы поворотов в трехмерном пространстве.

Матрица преобразования поворота относительно оси 
[image: image116.wmf]X

 на угол 
[image: image117.wmf]a

:
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Матрица преобразования поворота относительно оси 
[image: image119.wmf]Y

на угол 
[image: image120.wmf]b

:
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Матрица преобразования поворота относительно оси 
[image: image122.wmf]Z

 на угол 
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:
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· Матрица преобразования масштаба на вектор 
[image: image125.wmf](
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Цепочка преобразований

Более сложные преобразования описываются так же, как и для и плоскости. Предположим, например, что требуется выполнить преобразование поворота относительно оси 
[image: image127.wmf]X

 на угол 
[image: image128.wmf]a

 с последующим преобразованием на вектор 
[image: image129.wmf](
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. Матрица полного преобразования равна произведению матриц его составляющих:
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В следующем примере показано, что также просто получить матрицу, описывающую «классическое» геометрическое преобразование из матриц основных преобразований.
Пример. Осуществить преобразование поворота относительно произвольной прямой 
[image: image131.wmf]d

 на угол 
[image: image132.wmf]c

.
Для решения задачи прямую удобнее всего задать в параметрической  форме через точку 
[image: image133.wmf]P

, лежащую на прямой, и единичный вектор направления 
[image: image134.wmf]V

 (если, прямая задана в другой форме, достаточно ее привести к параметрической). Этапы решения следующие:
1)  преобразование переноса на 
[image: image135.wmf]P

-

 для того, чтобы прямая проходила через начало координат:
2)  преобразования поворотов на угол 
[image: image136.wmf]a

 относительно оси 
[image: image137.wmf]X

, затем на
угол 
[image: image138.wmf]b

 относительно оси 
[image: image139.wmf]Y

. Углы 
[image: image140.wmf]a

 и 
[image: image141.wmf]b

 выбираются так, чтобы прямая

[image: image142.wmf]d

 после поворотов совпала с осью 
[image: image143.wmf]Z

 (рис. 2);
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3)  преобразование поворота относительно оси  
[image: image145.wmf]Z

 на угол 
[image: image146.wmf]с

;
4)  преобразования поворотов на угол 
[image: image147.wmf]b

-

 относительно оси Т и на

[image: image148.wmf]a

-

относительно оси 
[image: image149.wmf]X

;
5)  преобразование переноса на 
[image: image150.wmf]P

.
Замечание. Единственная трудность состоит в определении углов 
[image: image151.wmf]a

 и 
[image: image152.wmf]b

. Для вычисления угла 
[image: image153.wmf]a

 можно воспользоваться соотношениями:
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Отсюда матрица преобразования поворота для данного случая (из общего вида матрицы преобразования поворота относительно оси 
[image: image156.wmf]X

) имеет вид:
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Для определения угла 
[image: image158.wmf]b

 найдем сначала, как преобразуется вектор 
[image: image159.wmf]V

 после поворота на угол 
[image: image160.wmf]a

 относительно оси 
[image: image161.wmf]X

:
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Отсюда получаем выражение для угла 
[image: image163.wmf]b
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и для матрицы преобразования поворота на угол 
[image: image166.wmf]b

 относительно оси 
[image: image167.wmf]Y
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Параллельные и перспективные проекции

В технических чертежах применяются параллельные проекции, а перспективные обычно используют художники и архитекторы для изображения общих планов. Черчение с применением перспективных проекций более или менее сложных объектов довольно трудоемко, но использование вычислительной техники позволяет упростить эту процедуру. С помощью вычислительных устройств удалось коренным образом изменить саму постановку проблемы.

Итак, различают перспективные и параллельные проекции. Для получения перспективной проекции необходимо определить точки пересечения плоскости проекции (XOY) с прямыми, исходящими из центра проецирования (точка M) и проходящими через все точки объекта. 

M 
[image: image169.emf]XYXZpp


Рисунок 1 –  Перспективная проекция 1


[image: image170.emf]
Рисунок 2 –  Перспективная проекция 2

Параллельные проекции определяются аналогично, за исключением того, что центр проецирования находится на бесконечности (все прямые параллельны).

[image: image171.emf]
Рисунок 3 –  Параллельная проекция 1

Для проведения параллельных проецирующих прямых, указывается некоторое направление проецирования относительно плоскости проекций.
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Рисунок 4 –  Параллельная проекция 2

Аксонометрические проекции
Во многих случаях при выполнении технических чертежей оказывается необходимым иметь изображения более наглядное. Для построения таких изображений применяются проекции, называемые аксонометрическими. Название аксонометрия образовано из слов древнегреческого языка: аксон – ось и метрио – измеряю. Способ аксонометрического проецирования состоит в том, что данная фигура вместе осями прямоугольных координат, к которым она отнесена в пространстве, проецируется параллельно на некоторую плоскость, принятую за плоскость аксонометрической проекции (картинную плоскость). Таким образом можно сказать, что аксонометрической проекцией называется параллельная проекция, у которой порождающие прямые перпендикулярны плоскости проекции. 

Пространственная система координат OXYZ с единичными отрезками е  по осям координат проецируется на аксонометрическую плоскость Р с осями О1X1, O1Y1, O1Z1 с аксонометрическими масштабами ex, ey, ez ( как показано на рисунке). Отношение 
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 называются коэффициентами искажения по аксонометрическим осям. Известно, что 
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 , 
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 – углы между осями координат их проекцией на плоскость Р
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Тогда для прямоугольной аксонометрической проекции имеет место равенство 
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На рисунке показано построение окружностей в аксонометрических плоскостях.
Среди аксонометрических проекций различают:

· изометрию: в плоскости проекции углы между каждой парой осей равны или если 
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. Изометрические оси между собой составляют угол 120о.


[image: image188.emf]Z Y

X

О


· диметрию: в плоскости проекции равны между собой два угла между осями или если 
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. Для такой проекции коэффициенты по осям X и Z принимаются равным 1 , а по оси Y – 0,5/
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· триметрию: в плоскости проекции все три угла между осями различны, т.е. 
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Косоугольные проекции

Для косоугольных проекций проецирующие прямые составляют с плоскостью проекции угол, отличный от 90 градусов. 


[image: image194.emf]XYXZbxpyp


Рисунок 5 – Косоугольная проекция
Различные типы косоугольных проекций характеризуются величиной этого угла. Выделяют два типа косоугольных проекций:

· свободную проекцию: угол между проецирующими прямыми и плоскостью проекции, равна 45 градусов;

· кабинетную проекцию: частный случай свободной проекции, в котором масштаб по третьей оси уменьшен в два раза.


При использовании проективного проецирования стремятся получить такой вид изображаемого объекта, который наиболее реалистично отражал бы его, был бы возможно близок к восприятию человеческим глазом. При этом используются различные типы перспективного проецирования в зависимости от выбранной поверхности изображения (плоскость, сфера, цилиндр).


Матричные представления проекций


Для описания преобразований проецирования, так же как и других геометрических преобразований, будем использовать матрицы, векторы и однородные координаты. Рассмотрим матричные представления различных типов проекций.

Аксонометрические проекции. Аксонометрия является параллельной проекцией. Рассмотрим сначала ортогональные проекции в плоскости 
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. Матрицы преобразования проецирования этих случаев легко выводятся из определений 
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)

1

0

0

0

0

1

0

0

0

0

0

0

0

0

0

1

0

=

=

у

M

орт

,


[image: image200.wmf](
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Для ортографических проекций на плоскости 
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 необходимо применить еще преобразование переноса
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Изометрия, диметрия и триметрия получаются комбинацией поворотов, за которыми следует проекция из бесконечности. Если нужно описать проекцию на плоскость  
[image: image205.wmf]0

=

z

, то сначала необходимо осуществить преобразование поворота на угол 
[image: image206.wmf]b

 относительно оси 
[image: image207.wmf]Y

, затем на угол 
[image: image208.wmf]a

 относительно оси 
[image: image209.wmf]X

.



Косоугольная проекция. В косоугольных проекциях проецирующие прямые образуют с плоскостью проекции угол, отличный от 90 градусов. Рассмотрим проекцию на плоскость 
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(рис. 2) и предположим, что 
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являются составляющими косоугольной проекции единичного вектора 
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 на эту плоскость, т.е. вектор 
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Для свободной проекции 
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Перспективные проекции. Перспективную проекцию будем представлять в виде цепочки перспективного преобразования и преобразования проецирования на плоскость, предполагая, что проецирование осуществляется на плоскость  
[image: image221.wmf]0
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 (рис.3). 
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Перспективные проекции

В качестве точки проецирования выберем лежащую на оси 
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 точку 
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 лучей, исходящих из точки проецирования и проходящих через все точки объекта 
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Матрица такого преобразования перспективного проецирования имеет вид:


[image: image232.wmf](

)

1

0

0

0

1

0

0

0

0

0

1

0

0

0

0

1

z

перс

v

P

M

-

=

.
Лекция 4. Первое знакомство с CorelDRAW. Интерактивные эффекты панели графики. Работа с текстом и работа с файлами. Печать документа.

Интерфейс программы достаточно прост, и в начале работы, невозможно представить насколько мощны возможности графического редактора. 


Слева расположена панель графики, содержащая инструменты работы с графическим объектом и текстом. Справа размещается палитра цветов. В верхней части окна находится строка меню, стандартная панель инструментов и панель атрибутов (состав этой панели зависит от элемента, который вы выделите в данный момент).
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Рис 1. Окно редактора. Пристыковываемые окна.
Если щелкнуть правой кнопкой мыши на любой панели инструментов, то есть возможность добавить или удалить разные панели инструментов и элементы меню, пользуясь контекстным меню. 


Пристыковываемое окно – это окно, в котором сгруппированы по функциональному назначению параметры инструментов, эффекты объектов, документов.  


Если одновременно открыть несколько пристыковываемых окон, то они закрываются в правой части окна программы друг над другом. При этом видны ярлыки с их названиями.
Внизу окна имеется панель (строка) состояния, в которой указаны текущие цвета заливки (изображение ведра) и линий (изображение пера). Здесь же находится строка с подсказками и дополнительной информацией о текущем объекте.


В окне документа видна текущая страница документа. Окно документа снабжено полосами прокрутки, ярлыками страниц для быстрого перемещения между страницами, а также стрелки перехода на страницу.


Кнопка перехода вперед и назад на страницу заменяется знаком «+», если пользователь находится на последней или первой странице документа. С помощью этого значка создается новая страница документа.

Инструменты панели графики

Почти на всех кнопках панели графики в уголке имеется треугольник. Это говорит о то, что у соответствующего инструмента есть модификация.
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Выделение объектов, изменение формы объектов и масштабирования


Инструмент Pick (Выбор) предназначен для выделения и преобразования объектов. С его помощью можно также привести курсор в обычный вид, после работы с каким – либо инструментом.


Инструмент Shape (Форма) позволяет изменить форму объекта путем перемещения его узлов. Данный инструмент имеет несколько модификаций:
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· Knife (Лезвие) – для отрезания фрагментов графических объектов и объединения линий;
· Eraser (Ластик) – для стирания;
· Free Transform – (свободное преобразование) – для выполнения преобразования вида.

Инструмент Zoom (Масштаб) позволяет изменить масштаб изображения содержимого страницы.
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Инструменты рисования фигур и вывода текста


С помощью инструмента Freehand (Кривая) можно рисовать мышью произвольную кривую. Кроме того, в распоряжении пользователя есть следующие инструменты построения векторных кривых специального вида.
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· Bezier (Кривая Безье) – предназначена для рисования кривых Безье;

· Artistic Media (Художественные средства) – имитирует рисование кистью с применением различных художественных эффектов;
· Dimension (Размер линий) – используется для нанесения размерных линий;
· Interactive Connector ( Интерактивная, соединительная линия) – необходима для создания соединительных линий, которые будут автоматически видоизменятся вместе с объектом.

Инструмент Rectangle (Прямоугольник) используется для рисования прямоугольников.

Инструмент Ellipse (Эллипс) позволяет рисовать эллипсы, окружности, дуги и секторы.

Инструмент Polygon (Многоугольник) – предназначен для рисования многоугольников. Размещенный вместе с ним на панели графики инструмент Spiral (Спираль) позволяет рисовать спирали, а инструмент Graph Paper (Диаграммная сетка) – строить диаграммные сетки.

Инструменты Perfect Shapes (Автофигура) применяется для рисования базовых фигур и имеет следующие модификации:
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· Arrow Shapes (Стрелки) – рисование стрелок;
· Flowchart Shapes (Блок- схемы) – построение стандартных элементов блок-схем; 
· Star Shapes (Звезды) – рисование звезд;
· Callout Shapes (Выноски) – рисование выносок, например, таких, какими обозначают реплики героев комиксов.
Интерактивные эффекты

Инструмент Interactive Blend (Перетекание) используется для создания эффекта плавного перетекания одного объекта в другой. На панели графики он сгруппирован со следующими инструментами:

· Interactive  Contour(Ореол) – создание объектов, повторяющих форму другого объекта;

· Interactive Distortion (Деформация) – интерактивная деформация объектов;

· Interactive Envelope (Огибающая) – это специальное средство для работы с огибающими. С его помощью можно поместить объект в фигуру и изменить его форму в соответствии с ней;

· Interactive Extrude (Экструзия) – имитация трех мерности за счет «выдавливания» объекта в указанном направлении;

· Interactive Drop Shadow (Тень) – наложение тени;

· Interactive  Transparency (Прозрачность) – наложение эффекта прозрачности.

Выбор цвета и настройка свойств объекта

Инструмент Eyedropper (Пипетка) дает возможность использовать цвет объекта в качестве образца. Для этого, выбрав данный инструмент, щелкните на рисунке по необходимому вам цвету, затем переведите мышь на ту область, которую вы собираетесь залить этим цветом, и щелкните мышью удерживая нажатой клавишу Shift. 


Вместе с этим инструментом на панели графики расположен инструмент Paint bucket (Заполнитель), используемый для заливки области текущим цветом. При удержании нажатой клавиши Shift он берет образец заливки объекта, как пипетка, и делает его текущим.


Инструменты этой группы служат для настройки линий контура выделяемого объекта?

· Outline Pen Dialog (Диалоговое окно Outline Pen (Перо для контуров)) – открывает диалоговое окно с настройкой толщины, вида завершителей, цвета, стиля и других параметров, используемых для построения линий контура;

· Outline Color Dialog (Диалоговое окно Outline Color (Цвет контура)) открывает диалоговое окно для выбора цвета линий;

· No Outline (Удалить контур) – отменяет изменения линий контура для выделения объекта;

· Следующие пять кнопок задают толщину линий контура: сверхтонкая, 1 пункт, 2 пункта, 8 пунктов, 16 пунктов, 24 пункта;

· Color Docer Window (Пристыковываемое окно Color (Цвет)) – вызывает пристыковываемое окно Color (Цвет)ж

Следующая группа инструментов предназначена для настройки заливки выделенного объекта. Самый простой способ выполнить заливку – выделить объект и щелкнуть на нужной ячейки в палитре цветов.

· Fill Color Dialog (Диалоговое окно Fill Color (Цвет заливки)) – открывает диалоговое окно для выбора цвета однородной заливки;

· Fountain Fill Dialog (Диалоговое окно Fountain Fill (Градиентная заливка)) – открывает диалоговое окно для настройки градиентной заливки;

· Pattern Fill Dialog (Диалоговое окно Pattern Fill (Узорная заливка)) – открывает диалоговое окно для настройки заливки по шаблону;

· Texture Fill Dialog (Диалоговое окно Texture Fill (Текстурная заливка)) – открывает диалоговое окно для настройки заливки на основе текстуры;

· PostScript Fill Dialog (Диалоговое окно PostScript Fill (Заливка PostScript Fill)) – выбор упрощенного рисунка заливки;

· Color Docer Window (Пристыковываемое окно Color (Цвет)) - вызывает пристыковываемое окно Color (Цвет)).

Инструмент Interactive (Интерактивная заливка) используется для редактирования выполненной ранее заливки выделенного объекта. Модификация этого инструмента Interactive Mesh Fill (интерактивная сетчатая заливка) позволяет создать заливку из областей разной интенсивности цвета.

Панель атрибутов

Состав этой панели зависит от выбранного объекта и выполняемой команды. Если активен инструмент Pick (Выбор) и не выделены ни какие объекты, панель атрибутов содержит:

· Формат бумаги;

· Ширина и высота листа;

· Книжная ориентация;

· Альбомная ориентация;

· Для текущей страницы;

· Для всех страниц;

· Единицы измерения;

· Шаг при сдвиге с помощью клавиш перемещения курсора;

· Смещение копии при дублировании объекта;

· Привязать к сетке;

· Привязать к направляющим;

· Привязать к объектам;

· Считать заполненными;

· Настройки направляющих.

В этом режиме ее удобно использовать для установки параметров печатной страницы. Кнопка со значком замка, расположенная рядом с группой однотипных параметров, служит для изменения их области действия: если она нажата (разблокировка), этим параметрам можно задавать разные значения, в противном случае используется одно значение для всей группы (например, для всех углов прямоугольника задается одинаковый радиус закругления).

Стандартные элементы, появляющиеся на панели атрибутов при выделении объекта практически любого типа, следующие:

· Координаты центра объекта;

· Размер объекта;

· Изменение размеров относительно исходных;

· Угол поворота;

· Отразить по горизонтали;

· Отразить по вертикали;

· Степень закругления углов;

· Ко всем углам;

· Обтекание текстом;

· Толщина линий;

· Перенести на слой выше;

· Перенести на слой ниже;

· Преобразовать в кривые.

Работа с заливками

Для начала необходимо создать и выделить объект. Заливки можно применять к любым замкнутым областям и фигурам. Можно создать собственные образцы заливок.

Заливка цветом и текстурой


Чтобы залить выделенный объект однородным цветом, достаточно щелкнуть по нужной ячейке в палитре цветов.

Для того, чтобы заполнить объект текстурой, выделите его и выберите на панели графики инструмент Texture Fill Dialog Dialog (Диалоговое окно Texture Fill (Текстурная заливка)). Там можно выбрать из списка вид текстуры и построить его цветовые компоненты. 

Можно выбрать инструмент интерактивного редактирования заливка Interactive Fill (интерактивная заливка), наведите квадрат редактирования на область заливки и растяните его до нужной величины.

В панели атрибутов при выборе этого инструмента появляются дополнительные элементы, из которых стоит отметить раскрывающийся список с образцами текстуры, а также кнопку Transform Fill with Objects (Преобразовывать с объектом), включающую возможность преобразования заливки вместе с объектом.

Если с помощью инструмента Pick (выбор) снова выделить прямоугольник и попробовать залить фигуру областями разной интенсивности цвета, воспользовавшись инструментом Interactive Mesh Fill (Интерактивная сетчатая заливка), заливка приобретет вид сетки с узловыми точками, которые можно передвигать мышью.

Градиентная заливка

Заливка выделенного объекта цветовым переходом выполняется при помощи инструмента панели графики Fountain Fill Dialog (Диалоговое окно Fountain Fill (Градиентная заливка)). При выборе этого инструмента открывается диалоговое окно Fountain Fill (Градиентное заливка).

Тип распределения цветов в градиентном заливке выбирается из списка Type (Тип заливки). Щелкая по квадратикам в разделе Color blend (Смешение цветов), можно выбирать цветовые компоненты градиента. Положение средней точки (это точка, в которой цвета градиента присутствуют в разных пропорциях) в процентах относительно длины цветового перехода можно задать ползунком Mid-point (Средняя точка). Кроме того, можно указать наклон цветового перехода в счетчике Steps (Шаги) или ввести ограничения на изменение цветов в счетчике Edge pad (Пороговые цвета).
Вставка и редактирования объектов


Corel позволяет добавить на страницу объект, используя инструмент Perfect Shapes (Автофигуры), который дает возможность рисовать различные стандартные фигуры. Выбрав из списка необходимую фигуру, можно вставить ее на страницу. 


При выделении фигуры вокруг нее появляется рамка с квадратными маркерами. С помощью угловых маркеров можно изменить размер объекта без искажения пропорций, а остальные маркеры позволяют изменить размеры произвольно. 

Если щелкнуть на выбранной фигуре второй раз, в углах появятся закругленные стрелочки. Они служат для поворота объекта и смещения его частей. 

Если щелкнуть по выбранному объекту правой кнопкой мыши, то появится контекстное меню. Выбрав в нем команду Object Properties (Свойства объекта), появится пристыковываемое окно, в котором можно просматривать и изменять свойства выделенного объекта. 

Лекция 5. Работа с графическим изображением с Corel DRAW. 

Настройка линий контура фигуры
Если выбрать инструмент Shape (Форма), затем щелкнуть в панели атрибутов на кнопке Star (Звезда), то в окне документа появится звезда.

Если выбрать инструмент (Полигон), то есть возможность построить многоугольники, звезды с возможность установки параметров 

Параметры звезды можно настроить как через панель атрибутов, так и в пристыковываемом окне со свойствами объекта, вызываемом командой Object Properties (Свойства объекта) контекстного меню.


[image: image239.emf]    



[image: image240.emf]
В панели атрибутов можно установить счетчик количества узлов. Если затем щелкнуть на кнопке с изображением многоугольника, то получится многоугольник с теми же параметрами, что и звезда.

Изменить вид линий контура звезды можно выбрав инструмент Outline Color Dialog (диалоговое окно Outline Color (Цвет контура)), здесь можно задать цвет и толщину линий контура. 

! Обратите внимание, что контур имеет узловые точки и если схватить одну из них мышью и переместить то остальные узловые точки также переместятся.
Эллипсы, дуги и сектора

Эллипс можно получить с помощью инструмента Ellipse (Эллипс). Чтобы получить круг надо удерживать нажатой клавишу Ctrl в процессе рисования.
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Инструмент Ellipse используется и для рисования секторов и дуг. Задать начальный и конечный угол сектора или дуги можно как в пристыковываемом окне свойств объекта, так и в панели атрибутов. Там же указывается и направление отчета угла – по часовой стрелки (Clockwise) или против (Counterclockwise) чтобы превратить сектор в дугу щелкните на кнопку Arc (Дуга) панели атрибутов.

Спирали

Для рисования спирали следует выбрать инструмент Spiral (Спираль). Элементы управления позволяют вычерчивать самые разнообразные спирали: можно задать число витков, симметричность, а также степень расширения.
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Диаграммная сетка
Используя инструмент Graph Paper (Диаграммная сетка) можно легко получить лист, разграфленный на нужное количество клеток. В панели атрибутов можно указать количество ячеек по горизонтали и вертикали. При необходимости созданную область можно разбить на отдельные ячейки командой меню Arrange – Ungroup (Монтаж – Разгруппировать).

Рисование линий

Инструмент Bezier (Кривая Безье) позволяет быстро и точно строить кривые достаточно сложной формы. Кривая Безье состоит из узлов и соединяющих эти узлы линий, причем линии могут быть плавно изогнутыми или прямоугольными. Узлы, соединенные линией, образуют сегмент. Созданную кривую можно модифицировать как в целом, так и по отдельным сегментам, меняя форму сегментов и положение узлов, добавляя и другие параметры. Обратите внимание, что узлы могут быть разных типов – точка перегиба, симметричный или сглаживающий узел, и в панели атрибутов имеются кнопки для изменения типа узла.

Форма участка между двумя узлами определяется двумя углами между касательной , проходящей через узел, и прямой, соединяющей соседние узлы. В процессе редактирования сегмента эти линии отображаются пунктиром, кроме того, выводятся так называемые направляющие точки узла – это точки, лежащие на касательной, проходящей через узел. Меняя положение направляющих точек, вы можете воздействовать на форму участка. 
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Выбрав инструмент Bezier (Кривая Безье), нужно щелкать мышью в тех точках страницы, где вы хотите разместить узлы, и с помощью направляющих точек узлов установить требуемую форму сегмента. 

Инструмент Artistic Media (Художественные средства)

Инструмент рисования Artistic Media (Художественные средства) представляет собой средство создания линий с различными художественными эффектами. Цвет кисти можно изменить, так же как и цвет линий контура для любой фигуры. С помощью панели атрибутов можно выбрать режим рисования (рисование с использованием штрихов из списка заготовок, кисти, распылителя, каллиграфического пера или пера с нажимом), кроме того, можно включить режим сглаживания кривой, а также изменить ее толщину. 
Тень

Инструмент Interactive Drop Shadow (Тень) создает тень от выделенного объекта. Для этого надо выделить объект и активизировать данный инструмент; для формирования тени компьютеру может понадобиться определенное время. Когда объект с тенью выделен, отображается линия, указывающая направление тени, с двумя квадратными маркерами и ползунком. Белый маркер определяет расстояние между тенью и объектом, а также цвет тени, черный маркер – режим отображения тени (плоская или в перспективе), а ползунок фиксирует степень прозрачности тени. 
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В панели атрибутов имеется возможность задать угол падения тени, степень непрозрачности, величину и направление размывки краев тени, затухание, растяжение, цвет тени.

Прозрачность

Инструмент Interactive Transparency (Прозрачность) позволяет регулировать уровень прозрачности объекта, а также тип и режимы прозрачности. Для настройки прозрачности объекта следует выделить его и активизировать данный инструмент.
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Следует обратить внимание, что элементы панели атрибутов в этом случае во многом аналогичны параметрам Интерактивная заливка. Типы прозрачности аналогичны типам заливки: помимо простейшего типа – однородной прозрачности – к объекту может быть применена градиентная и даже узорчатая или текстурная прозрачность. Способ наложения маски прозрачности выделенного объекта на цвета объектов, расположенных на заднем плане, определяются режимом прозрачности: например, в режиме Normal (Обычный) белый цвет является абсолютно непрозрачным, а оттенки серого передают прозрачность в соответствии со степенью насыщенности цвета. 

Векторная экструзия

Инструмент Interactive  Extrude (Экструзия) применяется для того, чтобы на основе двумерного векторного объекта создать трехмерный векторный объект. Рассмотрим этот процесс подробнее. Выделите объект, к которому вы хотите применить данный эффект, а затем активизируйте инструмент Экструзия. Далее протащите курсор инструмента в любом направлении. После этого вокруг объекта появится контур с маркером, по которому можно судить о направлении и глубине экструзии. Маркером в виде буквы «Х» отмечена так называемая точка схода лучей экструзии. Перемещая точку схода, можно установить требуемый вид экструзии, после чего кнопку мыши можно отпустить. В результате образуется трехмерный объект. Обратите внимание, что исходный объект динамически связан с элементами экструзии.

Данный эффект обладает множеством настроек. В панели атрибутов можно выбрать готовое сочетание настроек из списка Presets (Заголовки), создать или удалить собственный вариант эффекта (кнопками со значками «+» «-»). Кроме того, в панели атрибутов задается вид эффекта  (векторный или растровый), положение исходного объекта, тип экструзии (назад, вперед, с уменьшением, с увеличением и т.п.), глубина экструзии, координаты точки схода лучей и свойства этой точки. Точка схода лучей может быть привязана либо к объекту (VP Locked to Object) – тогда при перемещении объекта движется и точка схода, либо к странице (VP Locked to Page), и тогда при перемещении объекта она остается неподвижной.


[image: image247.emf] 



[image: image248.emf]
Задав основные параметры экструзии, такие как направление, тип, глубина и др., можно перейти к настройке освещенности и скосов (фасок), усиливающих эффект трехмерности. Цвет скосов задается параметром Bevel Color (Цвет скосов) в окне Color (Цвет) панели атрибутов. 

Поворот объекта с экструзией осуществляется кнопкой панели атрибутов Extrude Rotation (Поворот экструзии) и в появившемся окне надо повернуть мышью трехмерный манипулятор с логотипом Corel. Если отпустить кнопку мыши, результат экструзии повернется в соответствии с положением данного манипулятора. Кнопка со знаком Х внизу этого окна возвращает объект в исходное состояние, а кнопка в правом нижнем углу позволяет переключиться в такой режим вращения, при котором поворот задается как величина наклона объекта относительно осей X, Y, Z в процентах от –100 до 100 %.

Растровая экструзия  

Эффект растровой экструзии обладает некоторой особенностей, на которые следует обязательно обратить внимание. В режиме растровой экструзии трехмерное изображение, полученное на основе двумерного векторного объекта, преобразуется в растровое. За счет этого эффект приобретает большую реалистичность.

Однако в процессе создания растровой экструзии не используются точки схода, и поэтому в данном режиме вы не сможете получить несколько объектов с одинаковыми точками схода – объем имитируется для каждого объекта отдельно. Далее, в отличие от случая векторного эффекта, заливка исходного объекта всегда распространяется на результат растровой экструзии, то есть использовать разные виды заливок для исходного объекта и экструзии невозможно. Еще одно отличие – это невозможность отменить примененный эффект: векторный объект после преобразования в растровый не может вернуться к начальному состоянию. Поэтому для удаления эффекта следует воспользоваться командой Edit ► Undo (Правка ► Отменить).

В панели атрибутов можно воспользоваться заготовками эффекта из списка Preset (Заготовки), установить форму скосов передних и задних кромок, выбрать и настроить источники освещения.

Деформация

Interactive Distortion (Деформация) – это инструмент интерактивной деформации объектов. Выделив объект, выберите данный инструмент в панели графики и щелкните в панели атрибутов на кнопке, включающей требуемый режим деформации. Перетаскивая мышью маркеры параметров (амплитуды, угла и др. их количество зависит от режиме деформации) или используя панель атрибутов, можно изменить объект так, как вам необходимо. В процессе интерактивного редактирования объекта предварительный результат показывается светлыми контурами. Обратите внимание, что объект имеет также специальный маркер центра, который можно перетаскивать, существенно искажая вид объекта. Чтобы вернуть центр деформации в исходное положение, следует щелкнуть на кнопке панели атрибутов Center Distortion (Центрировать деформацию).

Результат применения данного эффекта в значительной мере зависит от выбранного режима деформации и от исходной фигуры, иначе он просто непредсказуем. Как и другие инструменты, реализующие различные визуальные эффекты, Деформация позволяет выбирать сочетания настроек из списка Presets (Заготовки), а также создавать или удалять их кнопками «+» и «-». Состав панели атрибутов определяется режимом деформации. 

В режиме Push And Pull (Тяни толкай) объект формируется так, что его выступающие элементы увеличиваются или уменьшаются. Это преобразование характеризуется единственным параметром – амплитудой, изменяющейся в пределах от –200 до 200%. Отрицательное значение амплитуды говорит о том, что деформация происходит в направлении центра объекта, а положительное – наоборот.

В режиме Zipper (Зигзаг) внешний вид объекта превращается в зигзаг. Степень деформации определяется амплитудой и частотой. Кроме того деформация может быть случайной (Random Distortion), сглаженной (Smooth Distortion) или локальной (Local Distortion). Если  применить деформацию в режиме Zipper (Зигзаг) к эллипсу, а затем сместить центр деформации, то получиться ежик.

Деформация в режиме Twister (Скрутка) представляет собой скручивание объекта относительно центра. В панели атрибутов можно выбрать направление скручивания, а также угол поворота (число полных поворотов и дополнительный угол).

Перетекание

Эффект перетекания объектов реализуется инструментом Interactive Blend (Перетекание). Нарисуйте на странице два объекта – они будут управляющими объектами, то есть один из них будет началом последовательности, а другой окончанием. Затем выберите в панели графики данный инструмент, щелкните на первом Объекте и, не отпуская кнопку мыши, переведите курсор ко второму объекту. В центре каждого объекта должен появится прямоугольный маркер. Отпустив кнопку мыши, вы получите эффект перетекания одного объекта в другой с плавным изменением поворота, формы и цвета объектов. При щелчке на образовательной группе перетекания 
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появляются квадратные маркеры управляющих объектов (в центре каждого объекта), а также треугольные маркеры, позволяющие ускорить изменение формы и цвета объекта.

Можно также реализовать эффект перетекания вдоль заданной траектории. При этом на странице должна находится созданная ранее группа перетекания. Сначала нарисуйте линию, затем активизируйте инструмент Interactive Blend (Перетекание) и щелкните на имеющейся группе перетекания. В панели атрибутов щелкните на кнопке Path Properties (Свойства пути) и выберите в раскрывшемся списке пункт New Path (Новый путь). Щелкните на линии, определяющей траекторию, и группа перетекания разместится вдоль этой линии.
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Процесс изменения формы и цвета при перетекании можно ускорить или замедлить. Для этого следует щелкнуть на кнопке Object And Color Acceleration (Ускорение объектов и цвета) и в открывшемся окне установить требуемое значение ускорения при помощи ползунков.
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В этом окне имеется также кнопка Link Acceleration (Связать ускорение): если она нажата, то ускорение цвета и формы будет происходить одновременно. Чтобы настроить их отдельно, переведите эту кнопку в не нажатое положение. Кроме того, с помощью счетчика панели атрибутов Number of Blend Steps (Количество шагов) можно изменить количество шагов последовательности перетекания.

Панель атрибутов позволяет выбирать сочетание настроек эффекта из списка заготовок, а также добавлять и удалять заготовки кнопками со значками «+» и «-». С помощью счетчика Blend Offset Spacing (Интервал) можно задать фиксированный интервал между шагами для группы перетекания по траектории. Следующей кнопкой – Blend Direction (Направление перетекания) – задается угол поворота объектов в группе перетекания. Кнопками Direct Blend (Прямое перетекание), Clockwise Blend (Перетекание по часовой стрелке) и Counterclockwise Blend (Перетекание против часовой стрелке) определяется способ построения цветового перехода, возможные варианты – вдоль прямой линии, соединяющей на цветовом круге цвета управляющих объектов, либо вдоль дуги в одном из двух направлений. 

Редактирование эффекта перетекания
Кнопка Miscellaneous Blend Properties (Дополнительные параметры перетекания), расположенная в панели атрибутов, предоставляет доступ к расширенным возможностям редактирования эффекта перетекания. При щелчке на этой кнопке выводится раскрывающееся меню с командами редактирования. 

Команда Map Nodes (Выбрать узлы) позволяет вручную отрегулировать положение тех узлов управляющих объектов, которые сопоставляются при построении эффекта перетекания. Переместить узлы объектов впоследствии можно инструментом Shape (Форма), что позволяет видоизменить эффект.

Команда Split (Расщепить) применяется для разделения группы перетекания на две последовательности. Выбрав эту команду, щелкните мышью в том месте перехода, где вы хотите его расщепить. В результате образуется две последовательности, а промежуточный объект, расположенный в точке расщепления, станет дочерним управляющим объектом.

Восстановить расщепленную последовательность перетекания можно при помощи команд Fuse Start (Соединить в начале) и Fuse End (Соединить в конце). Щелкните на последовательности, удерживая клавишу Ctrl, а затем следует выбрать команду. После этого дочерний управляющий объект превратится в обычный объект группы перетекания. В зависимости от количества объединяемых последовательностей необходимо повторить это несколько раз.

В раскрывающемся меню кнопки Miscellaneous Blend Properties (Дополнительные параметры перетекания) имеется также два флажка: флажок Blend Along Full Path (Перетекание вдоль всей траектории) распределяет объекты группы перетекания согласно длине траектории, а Rotate All Object (Поворачивать все объекты) поворачивает все объекты группы перетекания так, чтобы они следовали изгибам траектории.

Эффект огибающей  

Эффект Interactive Envelope (Интерактивная оболочка) позволяет заключить объект в огибающую любой формы, а затем произвольно исказить его, изменяя огибающую. Этот эффект часто применяется к тексту для имитации объема и глубины. Выделите объект и активизируйте данный инструмент. Вокруг выделенного объекта образуется рамка с узлами – перетаскивая узлы рамки мышью, можно свободно менять форму огибающей вместе с объектом. Можно добавить новую огибающую, поверх имеющейся, но это редко имеет смысл.
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С помощью огибающей можно преобразовать не только текст, но и любое изображение. После этого можно наложить на рисунок и другие эффекты.

Ореол

Эффект создаваемый инструментом Interactive Contour (Ореол), заключается в построении ореола из концентрических контуров вокруг объекта. Следует выделить объект и активизировать данный инструмент, а затем щелкнуть мышью на объекте и перетащить курсор в направлении изменения интенсивности цвета. После отпускания кнопки мыши получается объект со ступенчатым цветовым заполнением, при большом числе шагов похожем на градиентную заливку, только с тем отличием, что интенсивность в данном случае меняется в направлении от центра и зависит от формы контура цвета.
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Работа с текстом
В CorelDRAW  существуют два вида текста – фигурный и блочный. Фигурный текст применяется обычно для создания коротких фрагментов – заголовков, лозунгов, и.п., к которым будет применятся различные визуальные эффекты. Чтобы создать фигурный текст, выберите инструмент Text (Текст), щелкните в определенном месте страницы и начните ввод.

Блочный текст необходим для создания продолжительных текстовых областей с разнообразным форматированием и вводится следующим образом: после выбора инструмента Text (Текст) сначала растяните мышью область ввода, а затем щелкните внутри нее а вводите текст. Размер этой области можно впоследствии изменить так же, как  размер любой фигуры или объекта.

Лекция 6. Работа с графическим изображением

Возможности обработки растровой графики, предлагаемые в CorelDRAW, впечатляют. Помимо развитых средств настройки растровых изображений в программе имеется огромный выбор фильтров, позволяющих применять к ним разнообразные художественные и корректирующие эффекты. Кроме того, с помощью специального редактора растровой графики Corel PHOTO-PAINT, который можно запустить прямо из CorelDRAW, вы получаете возможность редактировать растровые рисунки, не покидая программы.
Настройка и преобразование растровых изображений

Рассмотрим преобразования и эффекты, применяемые к растровым изображениям с помощью команд меню Effects (Эффекты). Эти команды позволяют не только выполнять корректирующие операции, но и применять к изображению различные художественные эффекты.
Диалоговое окно эффектов
При выборе команд из меню Effects (Эффекты) открывается диалоговое окно фильтров и эффектов. Чтобы увидеть предварительные результаты ваших манипуляций с параметрами эффекта, нужно щелкнуть на кнопке с изображением глаза или на кнопке Preview (Предварительный просмотр). Если кнопка с изображением замка находится в нажатом состоянии, то изменения параметров автоматически проявляются в окне предварительного просмотра, в противном случае для просмотра изменений придется каждый раз нажимать кнопку Preview (Предварительный просмотр). Внизу окна расположена синяя полоса, показывающая, закончена ли генерации изображения предварительного просмотра. Масштаб предварительного просмотра изменяется щелчком мыши — левая кнопка увеличивает изображение, правая уменьшает. Для окончательного применения эффекта к изображению следует щелкнуть на кнопке ОК
Команды цветокоррекции
С помощью команд подменю Effects ► Adjust (Эффекты ► Настройка) можно провести коррекцию различных цветовых характеристик изображения. Ниже перечислены эти команды и их основные параметры.
· Contrast Enhancement (Улучшение контраста) — команда, позволяющая изменить контрастность изображения. При выборе этой команды открывается диалоговое окно Contrast Enhancement (Улучшение контраста). В нем вы можете расширить или сузить определенный диапазон значений яркости как в отдельном канале, так и на всем изображении сразу. После того как выбраны цвета (при помощи кнопок с изображением пипетки), по которым будет определяться входной (при выбранном переключателе Set input values (Выбрать входные значения)) и выходной (при выбранном переключателе Set output values (Выбрать выходные значения)) диапазоны значений яркости, в верхней части гистограммы двумя треугольными указателями отмечается диапазон яркости пикселов входного цвета, a новые границы диапазона яркости показываются двумя нижними указателями. Устанавливать границы входного и выходного диапазонов яркости можно также путем перемещения нижних и верхних указателей прямо на гисто​грамме. Область изображения, подвергаемая воздействию, задается в рас​крывающемся списке Channel (Канал): можно изменять все каналы изобра​жения сразу или каждый по отдельности.
· Local Equalization (Локальное выравнивание) — эта команда позволяет под​строить контрасты между деталями изображения, задав ширину (Width) и высоту (Height) контрастирующих областей. В результате можно сделать изображение более детализированным, менее расплывчатым. Ино​гда одновременно с этим оно приобретает вид карандашного рисунка.
· Sample Target Balance (Баланс цветов) — используя эту команду, можно подстроить цвета изображения, заменив выбранный цвет (Sample) новым цветом (Target). Цвета можно выбирать как в раскрываю​щихся списках, так и прямо на рисунке при помощи трех кнопок выбора цвета с изображением пипетки (выделяющих темные, средние и светлые тона).
· Tone Curve (Кривая) — с помощью этой команды можно откорректировать цвета изображения, модифицируя тоновую кривую изображения. Этот эффект очень удобен для придания изображению ощущения теплоты без потери яркости. Кнопки Null (Выпрямить) и Balance (Выровнять) позволяют вернуться к стандартному виду кривой. Форму кри​вой можно изменить с помощью кнопок группы Curve Style (Стиль). На​стройки можно сохранить для последующего использования или загру​зить с диска.
· Auto Equalize (Авто) — автоматическое выравнивание контрастности.
· Brightness-Contrast-Intensity (Яркость-Контраст-Интенсивность) — в одноименном диалоговом окне можно подобрать индивидуально оптимальные значения яркости, контраста и интенсивности цветов изображения
· Color Balance (Баланс цвета) — эта команда дает возможность подобрать соотношение интенсивности цветов в парах Cyan-Red (Бирюзовый-Красный), Magenta-Green (Пурпурный-Зеленый), Yellow-Blue (Желтый-Синий). Можно обрабатывать отдельно самые темные (Shadows), средние (Midtones) и самые светлые (Hightlights) участки изображения. Используя этот эффект, можно легко превратить черно-белое изображение в цветное. Флажок Preserve luminance (Сохранить подсветку) позволяет изменять цвета изображения, внедренного с сохранением цветовой конфигурации ICC.
· Gamma (Гамма-коррекция) — эта команда позволяет акцентировать детали в малоконтрастных областях, не затрагивая блики и тени, за счет изменения диапазона воспроизводимых оттенков. Для настройки эффекта следует задать величину коэффициента контрастности от нуля до 10. Для повышения контраста коэффициент должен быть больше 1.
· Hue/Saturation/Lightness (Цветовой тон/Контрастность/Интенсивность) - с помощью этой команды можно выполнить настройку цветов на основе цветовой модели HSL. В диалоговом окне Hue/Saturation/Lightness (Цвето​вой тон/Контрастность/Интенсивность) следует выбрать пере​ключатель, соответствующий цвету, преобладающему в обрабатываемой части изображения, а затем с помощью ползунков определить тон, интен​сивность и яркость. При выборе переключателя Master (Все каналы) будут изменяться все каналы изображения.
· Selective Color (Избранные цвета) — эта команда используется для под стройки цветов изображения с использованием параметров цветовой модели. Как и для предыдущей команды, можно воздействовать на отдельные каналы изображения или на все сразу, выбрав нужный переключатель в нижней части окна.
· Replace Colors (Замена цветов) — команда, выполняющая замену выбранного цвета. Заменяемый (Old color) и заменяющий (New color) цвета можно выбирать с помощью кнопок с изображением пипетки. Можно подстроить составляющие цвета, отдельно работая с тенями (Shadows), полутонами (Midtones) и бликами (Highlights).
· Desaturate (Уменьшить насыщенность) — команда уменьшает насыщенность цветов, приближая изображение к полутоновому.
· Channel Mixer (Смеситель каналов) — эта команда позволяет изменить доли выбранного цвета в общем количестве цветов. Так можно не только превратить зеленую листву в желтую, но и изменить цвет неба, погоду и даже время года.
Обработка растровых изображений
Основные средства преобразования изображений находятся в меню Bitmapd (Точечная графика). С помощью перечисленных ниже команд можно выполнять обрезку изображений, переводить растровые изображения в векторные, трассировать растровые объекты, а также изменять их разрешение и размере.

· Edit Bitmap (Правка растрового объекта) — вызывает специализированный редактор растровой графики Corel PHOTO-PAINT.
· Crop Bitmap (Обрезка растрового объекта) — эта команда, позволяющая изменить обрезку растрового изображения, становится доступна, если при вставке растрового объекта была использована обрезка краев. Обрезка выполняется с помощью инструмента Shape (Форма).
· Trace Bitmap (Трассировка растрового объекта) — преобразование растрового изображения в векторное.
· Resample (Изменение размеров) — данная команда позволяет изменить размеры и разрешение изображения. При этом можно предусмотреть сглаживание цветовых переходов, что особенно необходимо при низких значениях разрешения, и сохранение пропорций изображения. Флажок Maintain original size (Сохранить исходный размер файла) фиксируем объем, занимаемый файлом изображения. Это значит, что при увеличение размеров изображения его разрешение будет уменьшаться, и наоборот.
· Convert To Bitmap (Преобразовать в растровый формат) — преобразует векторный объект в растровое изображение.
Изменение цветовой модели и палитры изображения
Вид изображения и возможности работы с ним во многом зависят от того, в какой цветовой модели и палитре оно представлено. Команды, изменяющие палитру или цветовую модель графического изображения, собраны в подменю Bitmaps ► Mode (Точечная графика ► Режим). Эти команды перечислены ниже.
· Black And White (Черно-белое) — преобразует изображение в черно-белое.
· Grayscale (Полутоновое) — перевод изображения в оттенки серого.
· Duotone (Дуплекс) — эта команда позволяет получить изображение с огра​ниченным количеством цветов. Например, цветное изображе​ние преобразовать в двухцветное. В раскрывающемся списке Туре (Тип) следует выбрать количество цветов (от одного до четырех). Щелкнув на цветовом квадратике, можно настроить каждый оттенок.
· Paletted (Палитра) — с помощью этой команды можно изменить палитру изображения. Изменение палитры обычно не только приводит к измене​нию, размеров файла, но и сказывается на виде самого рисунка. Так можно сократить количество используемых цветов палитры.  RGB Color (RGB) — перевод изображения в цветовую модель RGB.
· Lab Color (Lab) — перевод изображения в цветовую модель LAB.
· CMYK Color (CMYK) — перевод рисунка в цветовую модель CMYK. Обычно эта процедура бывает необходима при подготовке графики к выводу на пе​чать.
· Apply ICC profile (Применить цветовую конфигурацию) — в результате при​менения этой команды изображение приводится в соответствие выбран​ной цветовой конфигурации ICC. Чем более стандартизовано изображе​ние, тем более предсказуемы его качества.
Увеличение размеров изображения
Для улучшения вида некоторых эффектов бывает необходимо расширить область воздействия эффекта. Это можно осуществить с помощью одной из двух специальных команд меню Bitmaps (Точечная графика).
Команда Auto Inflate Bitmap (Автоматическое расширение) включает режим авторасширения. В этом случае, изображение будет автоматически увеличи​лся при применении какого-либо растрового фильтра. Чтобы задать точную величину расширения, следует воспользоваться командой Manually Inflate Bitmap (Ручное расширение изображения) и в диалоговом окне Inflate Bitmap (Расширение растрового изображения) ввести новые значения ширины и вы​соты изображения.

Связывание изображения с внешним файлом

Управление свя​зыванием в CorelDRAW осуществляется с помощью пристыковываемого окна Link Manager (Диспетчер связывания). Кроме того, в меню Bitmaps (Точечная графика) имеется две команды, часто используемые при работе со связанными объектами: команда Resolve Link (Разорвать связь) вне​дряет в документ изображение, если ранее оно было импортировано с сохра​нением связи с внешним файлом, а команда Update From Link (Обновить) позволяет обновить изображение, если внешний источник был модифици​рован.
Пристыковываемое окно Bitmap Color Mask (Цветовая маска)

Чтобы сделать отдельные цвета изображения прозрачными, следует восполь​зоваться пристыковываемым окном Bitmap Color Mask (Цветовая маска). Это окно вызывается командой меню Bitmaps ► Bitmap Color Mask (Точечная графика ► Цветовая маска).

Работа с цветовой маской осуществляется следующим образом. Открыв пристыковываемое окно Bitmap Color Mask (Цветовая маска), щелкните на кнопке с изображением пипетки и укажите на рисунке цвет, который вы хотите сделать прозрачным. Этот цвет появится в верхней строке пристыковываемого окна; флажок слева означает, что данный цвет задействован в цветовой маске. Щелкнув на кнопке Apply (Применить), вы увидите результат действия! цветовой маски на изображение. Чтобы добавить в список цветовой маски новый образец цвета, нужно щелкнуть на пустой строке списка, а затем на кнопке с изображением пипетки и указать на рисунке цвет. Ползунок Tolerance (Допуск) позволяет расширить область действия цветовой маски: он показывает, насколько близок должен быть цвет к образцу, установленно​му в списке пристыковываемого окна, чтобы также стать прозрачным.
Прочие команды работы с растровыми изображениями
В подменю Effects ► Transform (Эффекты ► Преобразования) собраны различные вспомогательные команды, изменяющие цветовую палитру изображения:
· Delinterlace (Убрать) — эта команда удаляет линии строчной развертки, ко​торые могут появиться, например, при получении изображения с компью​терного видеовхода. Дефект устраняется путем увеличения (Duplication)  или размытия (Interpolation) зерен цвета;
· Invert (Инвертировать) — замена цветов изображения на противополож​ные;
· Pasteurize (Пастеризовать) — команда, уменьшающая количество исполь​зуемых оттенков за счет объединения близких цветов в однотонные облас​ти.
Пристыковываемые окна эффектов
В предыдущей лекции мы говорили о работе с инструментами, позволяющими в интерак​тивном режиме применять к объектам различные эффекты, например, созда​вать перетекание фигур или ореол вокруг объекта. Большинство этих эффек​тов можно создавать и при помощи пристыковываемых окон, вызываемых командами меню Effects (Эффекты), что мы и рассмотрим в этом разделе. Более того, для некоторых эффектов, например для эффекта линзы, вообще нет интерактивных инструментов, и вся работа с ними возможна только через пристыковываемое окно. Работа с пристыковываемым окном эффекта отличается от работы с интерактивным инструментом только тем, что параметры инструмента, заданные в панели атрибутов, воздействуют на объект сразу, а для применения параметров пристыковываемого окна следует щелкнуть на кнопке Apply (Применить).
Artistic Media (Художественные средства)
При выборе команды меню Effects ► Artistic Media (Эффекты ► Художественные средства) появляется пристыковываемое окно Artistic Media (Художественные средства), дублирующее возможности одноименного инструменте панели графики. В верхней части этого окна представлены недавно использовавшиеся типы линий, а в нижней — образцы линий из выбранной коллекции заготовок, разные по форме, но имеющие кон​тур и заливку текущих цветов.
Blend (Перетекание)
Пристыковываемое окно Blend (Перетекание) открывается командой меню Effects ► Blend (Эффекты ► Перетекание). Это окно состоит из че​тырех страниц — Steps (Шаги), Acceleration (Ускорение), Color (Цвет) и Mis​cellaneous Blend Options (Прочие параметры перетекания), все элементы правления которых доступны в панели атрибутов при работе с инструмен​том Interactive Blend (Перетекание).

Contour (Ореол)
Для открытия пристыковываемого окна Contour (Ореол) следует выбрать ко​манду меню Effects ► Contour (Эффекты ► Ореол). По своим возможностям оно равнозначно инструменту Interactive Contour (Ореол) — все элементы управ​ления, находящиеся в этом окне, вы найдете в панели атрибутов.

Envelope (Огибающая)
Пристыковываемое окно Envelope (Огибающая), открываемое командой ме​ню Effects ►Envelope (Эффекты ► Огибающая). При работе с этим окном вам доступны те же параметры эффекта, что и в панели атрибутов при использовании инструмента Interactive Envelope (Огибаю​щая).

Extrude (Экструзия)
Чтобы открыть пристыковываемое окно Extrude (Экструзия), сле​дует выбрать команду меню Effects ►  Extrude (Эффекты ► Экструзия). Оно со​стоит из нескольких страниц — Camera (Камера), Rotation (Поворот), Light (Освещение), Color (Цвет) и Bevels (Скосы), содержащих параметры экстру​зии, доступные в панели атрибутов при работе с инструментом Interactive Extrude (Экструзия).

Lens (Линза)
Работа с эффектом Lens (Линза) возможна только через пристыковываемое окно Lens (Линза), вызываемое командой меню Effects ► Lens (Эффекты ► Линза). Эффект линзы воздействует на область, являющуюся пе​ресечением двух объектов, и вносит искажения, аналогичные возникающим при просмотре предмета через реальную линзу. У объекта, используемого в качестве линзы, учитываются при этом только параметры контура, а свойст​ва заливки во внимание не принимаются.
Чтобы применить эффект линзы, следует сначала разместить на странице два объекта с заливкой так, чтобы они перекрывали друг друга. Затем необходимо выделить объект, находящийся на переднем плане, и открыть при стыковываемое окно Lens (Линза). Далее нужно выбрать в раскрывают списке тип линзы и задать степень искажающего эффекта в счетчике Raid (Уровень). Для линзы типа Color Limit (Светофильтр), поглощающей определенный цвет, в списке Color (Цвет) можно выбрать цвет светофильтра. Настроив параметры, эффект необходимо применить, щелкнув на кнопке Apply (Применить), если кнопка с изображением замка не нажата. Если же эта кнопка нажата, то объекты изменятся автоматически. По умолчанию воздействие распространяется на объекты всех слоев ниже слоя линзы.

Частое применение находит линза Fish Eye (Рыбий глаз), искажающая объекты так, что они становятся выпуклыми или вогнутыми, линза типа Transparency (Прозрачная), делающая объекты прозрачными, а также линза Invert! ( Инвертирующая).
Установив флажок Viewpoint (Точка обзора), вы получаете возможность перемещать точку обзора, в результате чего можно будет увидеть не только изображение, находящееся непосредственно под линзой. В пристыковываемом окне Lens (Линза) при этом появляется кнопка Edit (Изменить). Щелкнув на ней, вы увидите в центре объекта маркер точки обзора в виде крестика, который можно перетащить в любое место страницы. Флажок Remove Face (Удалить фон) запрещает использование фона страницы при: наложении эффекта. Если вы установите флажок Frozen (Фиксировать), то изображение, полученное в контуре линзы, станет самостоятельным объектом, и не будет изменяться при перемещении линзы.
Эффект PowerClip (Фигурная обрезка)
Эффект фигурной обрезки заключается в удалении частей объекта, высту​пающих относительно другого объекта. Первый объект при этом называется содержимым, а второй — контейнером. Вы всегда можете отменить эффект фигурной обрезки и вернуть объект к исходному состоянию.
Команды работы с эффектом фигурной обрезки собраны в подменю Effects ► Power Clip (Эффекты ► Фигурная обрезка). Для создания эффекта следует раз​местить объекты - содержимое относительно контейнера так, как они должны выглядеть после обрезки, и выбрать команду меню Effects ► Power Clip ► Place Inside Container (Эффекты ► Фигурная обрезка ► Поместить в контейнер). Кур​сор примет вид жирной стрелки, которой нужно щелкнуть на объекте-контей​нере. После этого объекты поместятся в контейнер. Допускается многоуровневая фигурная обрезка, то есть помещение в контейнер тех объ​ектов, которые, в свою очередь, также являются контейнерами.
Объекты, помещенные в контейнер, полностью сохраняют все свойства, и от​секаемые при обрезке части не удаляются, а просто становятся невидимыми. Чтобы отредактировать их, нужно выделить эффект и выбрать команду ме​ню Effects ► Power Clip ► Edit Contents (Эффекты ► Фигурная обрезка ► Изменить содержимое). В режиме редактирования можно изменять объекты любым способом. Контейнер при этом отображается в виде контура, а в нижнем ле​вом углу окна появляется кнопка Finish editing this level (Завершить изменения текущего уровня), предназначенная для окончания редактирования.

Команда Effects ► Power Clip ► Extract Contents (Эффекты ► Фигурная обрезка ► Извлечь содержимое) извлекает из контейнера содержимое и возвращает все! объекты в исходное состояние. В случае многоуровневой фигурной обрезки команду извлечения придется повторять для каждого вложенного контейнера.
Создание меняющихся кнопок
В подменю Effects ► Rollover (Эффекты ► Интерактивные кнопки управления) сгруппированы команды, позволяющие создавать и редактировать элементы  управления, способные менять свой вид в ответ на нажатие и щелчок мыши, а при щелчке мышью еще и выполнять переход по гиперссылке или, например, воспроизводить звуковой файл.
Чтобы превратить объект в интерактивную кнопку управления, выделите! его и выберите команду меню Effects ► Rollover ► Create Rollover (Эффекты ►Интерактивные кнопки управления ► Создать кнопку управления). Далее нужно выбрать команду меню Effects ► Rollover ► Edit Rollover (Эффекты ► Интерактивные кнопки управления ► Изменить кнопку управления), чтобы задать вид кнопки в различных состояниях. В этом режиме внизу окна появляются три кнопки, позволяющие переключаться между редактированием трех состояний интерактивной кнопки управления — Normal (Обычное), Over (Выделена) и Down (Нажата), а также кнопка выхода из режима редактирования Finish editing Rollover (Завершить изменение кнопки управления).

Для отмены эффекта следует выделить кнопку, а затем выбрать команду меню Effects ► Rollover ► Extract All Objects From Rollover (Эффекты ► Интерактив​ные кнопки управления ►Извлечь все объекты). После этого изображения, соответствующие различным состояниям кнопки, окажутся просто наложен​ными друг на друга.
Для работы с интерактивными кнопками управления можно использовать не только команды меню, но и панель инструментов Internet (Интернет). Чтобы вывести ее на экран, можно просто щелкнуть правой кноп​кой мыши в любом месте любой панели инструментов, а затем в появившем​ся списке выбрать пункт Internet (Интернет).
Эффект перспективы
Команда Effects ► Add Perspective (Эффекты ► Перспектива) применяет к объекту эффект перспективы. Так можно придать изображению глубину, имитируя трехмерность. Форму объекта с перспективой можно менять, перетаскивая точки схода или используя инструмент Shape (Форма) для перемещения узлов объекта.

Копирование, клонирование и отмена эффектов
Команда Effects ► Copy Effect (Эффекты ►Копировать) с) позволяет применить к объекту эффект, наложенный на другой объект. При выборе этой команды I следует указать объект, являющийся источником параметров эффекта. С помощью команды Effects ► Clone Effect (Эффекты ► Клонировать) осуществляется клонирование эффектов выделенного объекта. В отличие от обычных! копий, клоны сохраняют связь с объектом-источником и изменяются вместе с ним. Для отмены эффектов, наложенных на объект, следует выделить его и выбрать команду меню Effects ► Clear Effect (Эффекты ► Отменить эффект).
Лекция 7. Растровые фильтры
В этом разделе описываются растровые эффекты, доступные в меню Bitmaps (Точечная графика). Если команды меню Effects (Эффекты) используются преимущественно для коррекции и настройки изображений, то основное назначение растровых фильтров — это достижение различных спецэффектов и имитация реальных инструментов рисования. Диалоговое окно растровых фильтров устроено аналогично окну эффектов, о котором мы говорили ранее. Ниже рассмотрены растровые фильтры, объединенные в группы в меню Bitmaps (Точечная графика).
Группа фильтров 3D Effects (ЗD-эффекты)
В подменю Bitmaps ► 3D Effects (Точечная графика ► ЗD-эффекты) сгруппированы различные растровые фильтры, позволяющие имитировать объемные изображения:

· 3D Rotate (Трехмерный поворот) — поворот объекта в трехмерной плоско​сти. Вращение выполняется путем перетаскивания трехмерной модели объекта в окне настройки.
· Cylinder (Цилиндр) — «закручивание» объекта вокруг цилиндра.
· Emboss (Рельеф) — создает иллюзию рельефности изображения. Эффект достигается за счет особого распределения света.
· Page Curl (Загиб страницы) — закручивание уголка объекта 
· Perspective (Перспектива) — придает изображению эффект глубины. В ре​жиме Shear (Сдвиг) можно добиться усиления эффекта за счет смещения частей объекта в пространстве.
· Pinch/Punch (Вдавливание-выдавливание) — имитация вдавливания части объекта внутрь или, наоборот, вытягивания вверх.
· Sphere (Сфера) — позволяет сделать рисунок вогнутым или выпуклым.
Группа фильтров Art Strokes (Художественные средства)
Фильтры, находящиеся в подменю Bitmaps ► Art Strokes (Точечная графика ►Художественные средства), позволяют придать растровому изображению такой вид, как будто оно нарисовано реальным инструментом (кистью, карандашом, углем) или в определенном художественном стиле. Ниже перечислены эти фильтры и приведены примеры их действия:
· Charcoal (Рисунок углем) — в результате применения этого фильтра растровое изображение становится похоже на рисунок углем.
· Conte Crayon (Пастельный карандаш) — имитация рисования пастельным карандашом. Можно варьировать цвет карандаша, цвет и фактуру бумаги, а также силу нажима.
· Crayon (Восковой карандаш) — этот фильтр делает изображение похожим на рисунок восковым карандашом.
· Cubist (Кубизм) — фильтр, имитирующий рисование в абстрактном стиле. Изображение начинает напоминать рисунок, сделанный мазками в форме кубов.
· Impressionist (Импрессионизм) — имитация рисования в стиле импрессио​низма. Palette Knife (Шпатель) — придает изображению вид рисунка, обработанно​го гибким ножом, когда краска наносится инструментом в виде шпателя (так называемым мастихином).
· Crayon (Восковой карандаш) — этот фильтр делает изображение похожим на рисунок восковым карандашом.
· Cubist (Кубизм) — фильтр, имитирующий рисование в абстрактном стиле. Изображение начинает напоминать рисунок, сделанный мазками в форме кубов.
· Impressionist (Импрессионизм) — имитация рисования в стиле импрессио​низма.
· Palette Knife (Шпатель) — придает изображению вид рисунка, обработанно​го гибким ножом, когда краска наносится инструментом в виде шпателя (так называемым мастихином).
· Pastels (Пастель) — рисунок меняется так, как будто он нарисован пастелью. Можно выбрать тип пастели — Soft (Карандаш) или Oil (Масло).
· Pen And Ink (Ручка и чернила) — имитация рисования чернилами.
· Pointillist (Пуантилизм) — этот фильтр применяет к изображению эффект нанесения красок отдельными точками.
· Scraperboard (Процарапывание) — результатом применения этого фильтра будет изображение, полученное путем снятия верхнего слоя краски.
· Sketch Pad (Карандаш) — с помощью этого фильтра изображение можно превратить в карандашный рисунок.
· Watercolor (Акварель) — фильтр, имитирующий технику рисования аква​рельными красками.
· Water Maker (Водный маркер) — имитация рисования водным маркером. Результат напоминает сочетание фильтров Watercolor (Акварель) и Impres​sionist (Импрессионизм).
· Wave Paper (Текстурная бумага) — превращает изображение в рисунок, выполненный на текстурной бумаге.
Группа фильтров Blur (Размытие)
В подменю Bitmaps ► Blur (Точечная графика ► Размытие) предлагается огромный выбор фильтров, выполняющих размывку изображения. Этот прием просто незаменим для создания фоновых изображений, когда требуется рас​певать второстепенные детали, а также для сглаживания объектов.
· Directional Smooth (Направленное сглаживание) — мягкое сглаживание в определенном направлении.
· Gaussian Blur (Размытие по Гауссу) — часто используемый эффективный вариант размытия. Результат в значительной степени зависит от радиуса размытия и при большом значении радиуса изображение может измениться до неузнаваемости.
· Jaggy Despeckle (Удаление пятен) — используется для удаления пятен и сгла​живания краев.
· Low Pass (Тонкая очистка) — этот фильтр позволяет применить сглаживание к участкам заданного размера.
· Motion Blur (Движение) — фильтр, создающий эффект движения с большой скоростью за счет сильного размытия в определенном направлении.
· Radial Blur (Радиальное размытие) — размытие применяется радиальная то есть максимальное проявление эффекта достигается в центре вращения.
· Smooth (Сглаживание) — тонкое сглаживание изображения.
· Soften (Смягчение) — представляет собой аналог предыдущего фильтра.
· Zoom (Фокусирование) — при применении этого фильтра размытие осла​бевает по мере удаления от точки приложения эффекта. Так можно получить широкий диапазон эффектов — от имитации объемной фи​гуры до разбегающихся кругов на воде.
Группа фильтров Color Transform (Цветовые эффекты)
В подменю Bitmaps ► Color Transform (Точечная графика ► Цветовые эффекты) содержатся фильтры, которые могут применяться как в целях коррекции изображения, например для устранения «красного глаза» на фотографии, так для получения не существующих в природе цветов.
· Bit Planes (Разбивка на цвета) — разбивает цветное изображение на базовые цвета (красный, зеленый, синий), предоставляя возможность менять ин​тенсивность цветовых составляющих. С помощью этого фильтра очень легко создать, например, инопланетный пейзаж.
· Halftone (Полутона) — разбивает растровое изображение на четыре полуто​новых изображения, содержащих цветовые каналы модели CMYK.
· Psychedelic (Психоделические цвета) — простое, но мощное средство при​дания рисунку особого настроения.
· Solarize (Соляризация) — этот фильтр насыщает рисунок цветом, в резуль​тате чего он становится похожим на цветной негатив фотографии.
· Red Eye Removal (Удаление эффекта «красного глаза») — помогает убрать на фотографическом изображении эффект «красного глаза». Вам нужно только указать, к какому глазу применять фильтр, и выбрать в палитре за​меняющий цвет.
Группа фильтров Contour (Контуры)
Три фильтра, находящиеся в подменю Bitmaps ► Contour (Точечная графика ► Контур), предназначены для работы с контурами на растровых изображе​ниях.
· Edge Detect (Показать контуры) — этот фильтр определяет контуры объек​тов по цветовым переходам и усиливает их, превращая в четкие линии. При этом нужно задать цвет фона, на котором будут показаны только контуры.
· Find Edges (Найти контуры) — данный фильтр действует аналогично пре​дыдущему, но позволяет более детально задать условия поиска контуров.
· Trace Contour (Выделить контуры) — с помощью этого фильтра можно выде​лить контуры в растровом изображении, основываясь на оттенках 16-цветной палитры.
Группа фильтров Creative (Созидание)
Фильтры группы Bitmaps ► Creative (Точечная графика ► Созидание) большей всего подходят для получения различных спецэффектов и имитации природных явлений. Ниже приводится описание действия этих фильтров.
· Crafts (Разбивка) — этот фильтр разбивает растровое изображение на отдельные элементы — цветовые составляющие, фигуры мозаики, кружочки стеклянные шарики и др.
· Crystalize (Кристаллизация) — имитирует просмотр изображения через полупрозрачное ограненное стекло.
· Fabric (Текстура) — разбивает растровое изображение на элементы текстуры. Так можно превратить изображение, например, в гобелен, плетенум поверхность или стеганое одеяло.
· Frame (Рамка) — помещает изображение в рамку. Можно воспользоваться рамкой из стандартных заготовок или создать собственный.
· Glass Block (Рифленое стекло) — изображение приобретает такой вид, как будто оно рассматривается через рифленое стекло или стеклоблок.
· Kids Play (Детские игры) — этот фильтр позволяет преобразовать изображение так, что оно станет похожим на картину, выложенную из блоков или просто нарисованную пальцем.
· Mozaic (Мозаика) — фильтр, превращающий изображение в мозаику.
· Particles (Частицы) — данный фильтр заполняет растровое изображение частицами — звездочками или пузырьками.
· Scatter (Разброс) — при воздействии этого фильтра уменьшается четкости цветовых границ на изображении, что напоминает просмотр через цветной стекло.
· Smoked Glass (Дымчатое стекло) — фильтр имитирует просмотр рисунка через закопченное стекло.
· Stained Glass (Витраж) — превращает изображение в подобие витража.
· Vignette (Виньетка) — помещает в центр страницы затененное по краям изображение.
· Vortex (Вихрь) — этот фильтр скручивает изображение относительно за​данной точки.
· Weather (Погода) — с помощью этого фильтра можно добавить на изобра​жение достаточно правдоподобные снег, дождь или туман.
Группа фильтров Distort (Искажение)
В подменю Bitmaps ► Distort (Точечная графика ► Искажение) содержатся пе​речисленные ниже искажающие фильтры разного вида.
· Blocks (Блоки) — разбивает изображение на отдельные блоки.
· Displace (Замещение) — с помощью этого фильтра можно создать эффект прозрачного искажающего стекла. На изображение можно наложить вол​ны, квадратики, пирамидки, точки, ямки.
· Offset (Смещение) — смещает изображение на заданную величину. Можно разрезать рисунок на несколько частей, переставить их и заполнить промежутки любым цветом.
· Pixelate (Объединение пикселов) — разбивает изображение на однородная по цвету области. Изображение становится зернистым.
· Ripple (Рябь) — фильтр вносит искажение в виде волн.
· Swirl (Скручивание) — скручивание изображения относительно задание точки.
· Tile (Изразец) — изображение становится похоже на выложенное из плиток.
· Wet paint (Избыток краски) — фильтр позволяет изобразить подтеки краски.
· Whirpool (Водоворот) — с помощью этого фильтра можно создать на изображении расположенные случайным образом водовороты различной формы.
· Wind (Ветер) — этот фильтр представляет собой аналог фильтра Motion (Движение) из группы Blur (Размытие), но обладает более мягким действием.
Группа фильтров Noise (Шум)
Фильтры, расположенные в подменю Bitmaps ► Noise (Точечная графика ► Шум), позволяют добавить в изображение случайность и изменяют его вид очень незначительно. Обычно они используются перед применением эффек​тов для удаления присутствующего на изображении «лишнего» шума.
· Add Noise (Добавить шум) — добавляет шум, который в зависимости от ус​тановленных параметров может затрагивать все цвета, случайно выбран​ные цвета или только один цвет изображения.
· Diffuse (Диффузия) — добавляет легкое проникновение цвета в соседние цвета.
· Dust And Scratch (Пыль и царапины) — фильтр, позволяющий имитировать запыленность и другие повреждения, характерные для старых фотогра​фий.
· Maximum (Максимум) — в процессе удаления шума этот фильтр заменяет цвета пикселов на цвета окружающих пикселов так, чтобы добиться мак​симальной интенсивности.
· Median (Промежуточный) — в отличие от предыдущего фильтра выполняет замену цветов с усреднением интенсивности.
· Minimum (Минимум) — цвета пикселов заменяются цветами окружающих пикселов так, чтобы интенсивность была минимальна.
· Remove Moire (Удаление разводов) — этот фильтр позволяет убрать с изо​бражения разводы (муар).
· Remove Noise (Удаление шума) — с помощью этого фильтра можно убрать помехи, не затрагивая важные части рисунка.
Группа фильтров Sharpen (Подчеркивание деталей)
Фильтры группы Bitmaps ► Sharpen (Точечная графика ► Подчеркивание де​талей) позволяют подчеркнуть детали изображения.
· Adaptive Unsharp (Адаптивный) — после применения этого фильтра конту​ры на растровом изображении становятся ярче и четче.
· Directional Sharpen (Направленное подчеркивание) — действует аналогично предыдущему фильтру, но обладает более направленным действием.
· High Pass (Добавление яркости) — этот фильтр устраняет слишком темные области изображения и выделяет более яркие, в результате рисунок стано​вится более контрастным и ярким.
· Shapen (Подчеркивание деталей) — данный фильтр повышает четкость и контрастность в размытых областях изображения.
· Unsharp Mask (Нечеткая маска) — повышая контрастность и четкость изображения, этот фильтр действует наиболее мягко.
Дополнительные растровые фильтры
С помощью команд подменю Bitmaps ► Plug-Ins (Точечная графика ►Подключаемые модули) можно загрузить установленные на вашем компьютере подключаемые модули, реализующие отдельные визуальные эффекты. 
· DigiMark (Цифровая подпись) — этот подключаемый модуль позволяет добавить в изображение водяные знаки, невидимые невооруженным глазом содержащие, например, данные об авторе.
· Corel Fancy Plug-Ins — эта программа состоит из двух модулей — Julia Sea Explorer  и Terrazzo, позволяющих создавать фрактальные узоре (узоры, полученные на базе фрактальной геометрии, заимствующей свои закономерности из принципов поверхностного распределения энергии).
· Squizz — программа, предоставляющая расширенные возможности работе с кистью и сеткой, используемая для внесения искажений в изображении.
· KPT (Kai's Power Tools) — этот модуль содержит три фильтра: Shape Shifter (Трансформирование), Smoothie (Сглаживание) и FraxFlame (Фрактальный узор).

_1157611556.unknown

_1157613817.unknown

_1157615129.unknown

_1157619061.unknown

_1157625841.unknown

_1318270597.unknown

_1318270813.unknown

_1318271016.unknown

_1318271213.unknown

_1318271586.unknown

_1318272430.unknown

_1318275102.unknown

_1318271750.unknown

_1318271290.unknown

_1318271367.unknown

_1318271254.unknown

_1318271119.unknown

_1318270854.unknown

_1318270863.unknown

_1318270827.unknown

_1318270740.unknown

_1318270804.unknown

_1318270614.unknown

_1160381524.unknown

_1318267768.unknown

_1318270534.unknown

_1318270539.unknown

_1318268559.unknown

_1318270360.unknown

_1160385943.unknown

_1160910717.unknown

_1160916866.unknown

_1318267410.unknown

_1160916969.unknown

_1160917666.unknown

_1160912567.unknown

_1160913027.unknown

_1160911715.unknown

_1160387264.unknown

_1160910593.unknown

_1160386915.unknown

_1160382999.unknown

_1160385359.unknown

_1160382783.unknown

_1157626407.unknown

_1157626605.unknown

_1157626961.unknown

_1160242071.unknown

_1157626870.unknown

_1157626505.unknown

_1157626547.unknown

_1157626459.unknown

_1157626247.unknown

_1157626286.unknown

_1157626312.unknown

_1157625933.unknown

_1157625953.unknown

_1157626185.unknown

_1157625892.unknown

_1157625495.unknown

_1157625668.unknown

_1157625784.unknown

_1157625798.unknown

_1157625718.unknown

_1157625572.unknown

_1157625644.unknown

_1157625558.unknown

_1157624311.unknown

_1157624429.unknown

_1157624488.unknown

_1157624744.unknown

_1157624775.unknown

_1157624917.unknown

_1157624760.unknown

_1157624721.unknown

_1157624437.unknown

_1157624332.unknown

_1157624419.unknown

_1157623814.unknown

_1157623841.unknown

_1157623857.unknown

_1157619089.unknown

_1157616528.unknown

_1157618513.unknown

_1157618696.unknown

_1157618967.unknown

_1157618990.unknown

_1157618950.unknown

_1157618552.unknown

_1157618688.unknown

_1157618531.unknown

_1157618255.unknown

_1157618332.unknown

_1157618481.unknown

_1157618262.unknown

_1157617980.unknown

_1157618144.unknown

_1157618163.unknown

_1157618006.unknown

_1157617967.unknown

_1157615208.unknown

_1157615252.unknown

_1157616367.unknown

_1157616497.unknown

_1157615312.unknown

_1157615276.unknown

_1157615240.unknown

_1157615185.unknown

_1157614374.unknown

_1157615039.unknown

_1157615095.unknown

_1157615059.unknown

_1157614812.unknown

_1157614836.unknown

_1157615023.unknown

_1157614635.unknown

_1157614645.unknown

_1157614137.unknown

_1157614277.unknown

_1157614317.unknown

_1157614276.unknown

_1157613965.unknown

_1157614126.unknown

_1157613949.unknown

_1157611680.unknown

_1157612155.unknown

_1157612198.unknown

_1157612644.unknown

_1157612658.unknown

_1157613573.unknown

_1157612207.unknown

_1157612357.unknown

_1157612172.unknown

_1157612180.unknown

_1157612165.unknown

_1157611697.unknown

_1157611949.unknown

_1157612142.unknown

_1157611729.unknown

_1157611690.unknown

_1157611694.unknown

_1157611686.unknown

_1157611626.unknown

_1157611662.unknown

_1157611668.unknown

_1157611677.unknown

_1157611665.unknown

_1157611656.unknown

_1157611660.unknown

_1157611632.unknown

_1157611594.unknown

_1157611607.unknown

_1157611609.unknown

_1157611604.unknown

_1157611587.unknown

_1157611591.unknown

_1157611558.unknown

_1157611261.unknown

_1157611317.unknown

_1157611466.unknown

_1157611495.unknown

_1157611500.unknown

_1157611522.unknown

_1157611497.unknown

_1157611481.unknown

_1157611491.unknown

_1157611469.unknown

_1157611344.unknown

_1157611459.unknown

_1157611462.unknown

_1157611453.unknown

_1157611330.unknown

_1157611333.unknown

_1157611327.unknown

_1157611324.unknown

_1157611291.unknown

_1157611303.unknown

_1157611309.unknown

_1157611315.unknown

_1157611307.unknown

_1157611298.unknown

_1157611300.unknown

_1157611294.unknown

_1157611276.unknown

_1157611283.unknown

_1157611288.unknown

_1157611281.unknown

_1157611270.unknown

_1157611272.unknown

_1157611265.unknown

_1156082705.unknown

_1157546821.unknown

_1157547371.unknown

_1157547523.unknown

_1157611252.unknown

_1157611256.unknown

_1157549093.unknown

_1157550655.unknown

_1157548177.unknown

_1157547466.unknown

_1157547498.unknown

_1157547436.unknown

_1157546857.unknown

_1157546871.unknown

_1157546830.unknown

_1157545581.unknown

_1157546768.unknown

_1157546789.unknown

_1157545598.unknown

_1157545479.unknown

_1157545516.unknown

_1157545541.unknown

_1156083042.unknown

_1157545050.unknown

_1157545063.unknown

_1156082964.unknown

_1156081417.unknown

_1156082526.unknown

_1156082637.unknown

_1156082683.unknown

_1156082603.unknown

_1156081739.unknown

_1156082457.unknown

_1156081685.unknown

_1156081397.unknown

_1156081411.unknown

_1156081414.unknown

_1156081406.unknown

_1156081401.unknown

_1156081388.unknown

_1156081391.unknown

_1156081381.unknown

_1156081385.unknown

_1156081372.unknown

_1156081377.unknown

_1156081368.unknown

